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About this Manual

Who this Manual is for

How this manual is
organized

Related
Documentation and
Software

Support Information

This User Guide includes the information you need to use the ECR Station
Viewer interface, one of the three main interfaces for the ECR Call
Recording System.

This manual is for “non-supervisor” end users who require access to the
call records for a specific telephone station.

This manual is organized into four main sections.

The first section (“The ECR Station Viewer Interface” on page 4) provides
an overview of the ECR Station Viewer and introduces users to the main

elements of the program, including the three main views in the program

(Station View, Statistics, and Call Finder).

The next section (“Call Record Context Functions” on page 10) provides a
description of all the things you can do when you select a call record. This
includes playing the record, emailing it, adding a comment to it, protecting
it, locking it, and much more.

The third section (“Tools Menu Functions” on page 15) provides a
description of various functions you can perform using the items under the
Tools menu. This includes maintaining recording hardware, shutting down
the recording system, exporting data to Excel, and changing the user
password.

The final section (“Options” on page 17) describes the various settings of
the program from the Tools>Options menu.

* ECR Installation and Setup Guide

* ECR Supervisor User Guide

* ECR Configuration Tool User Guide
* Hardware Quick-Start Guides

ECR includes one year of support from the date of purchase. Support
agreements are available to extend this support period. Please contact Algo
for information and pricing.

ECR Configuration Tool User Guide 2
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The ECR Station Viewer Interface

The ECR Station Viewer Interface

The ECR Station Viewer provides non-supervisory access to call records for
specific telephone stations. Subject to privileges granted by the ECR
Administrator, ECR Station Viewer users will be able to search for and play
back past call records, add comments, create statistical reports, send
emails of recorded calls, and much more.

Users accessing a station with the ECR Station Viewer are logged on as the
Station Operator, allowing ECR to track calls made by that user.

Getting Familiar

The Station Viewer Interface is made up of three main views:

* Station View (default startup view)

e Statistics
e Call Finder
Common Elements There are several common elements to the View windows in the ECR

Station Viewer Interface. These include:

* The Drop-Down Menu at the top of the screen
* Toolbar

* View Tabs

* Call Playback Panel

Drop-Down Menu

Fie § £k | [ vew | ook | 3
Save As... Emal... Station View Hardware Mairkenance. .. User Guids. ..
Copy. .. I Comments... Statistics Change Password... Abock
Incvidual Fies). .. I Call Finder Recerding Sysbem Commands...
From Directory... Export Data To Excel...
Ext
— Cplions...

The drop-down menu provides a consistent navigation system throughout
the Station Viewer Interface, available from all three main views.

Toolbar
L = E a
g B X o >
E-mail Comments | Quick Find Delete Protect Unprotect Lock Unlock,
The Toolbar contains icons for quick feature selection. For detailed
information on these icons, please refer to “Call Record Context Functions”
on page 10 . The Toolbar icons are greyed out when a call record is not
actively selected.
View Tabs

Station Yiew Statistics Call Finder |

ECR Station Viewer User Guide 4



Player Panel

The ECR Station Viewer Interface

The View Tabs make it easy to switch between Views. Simply click on the
tabs to change to the selected view.

Player

e '
un Yolume: J— Play Speed:

File: [ stn010_200906197T143512 wma | 00:00/ op:on

J

The Player Panel is for playing back selected call records. For more
information on this panel, please refer to “Tools Menu Functions” on
page 15 .

Station View

Telephone Status
Panel

Call History List

B Enerprinn Call Recarder - [S1atien Yiew]

Drop-Down Menu —— [t wen fas bee

— - . = =
Toolbar ——— | & | & L' X 3 & GS‘

Con | Commerts | QubPed | Dee | o ot Lek | ek
View Tabs —— Saaton Ve premes al Firer

4105 Analog AusBox S2ation: “AnalogPhons’

Uver:  jrutiedge [ o s |

Telephone Status —— '\'A tint Dlsplay: FOIISSLIN
Panel Comeents: o roers | =]

D000 =L

Trectest | Loadty &

Call History List

Tradesho schacdiing Cutgong
g

Proshct debvary scheckie Ercomeg

F
Frrting auctatn company teocures g

Player Pane| ———>

Fhere Sve Ty = BHABED = blssmn

The Station View is the primary interface to play back and manage
recorded conversations.

Along with Set Display and real-time Call Duration information, an
animated graphic in the Telephone Status Panel provides a visual
representation of telephone status. While on a call users can enter
comments about the call in the Comments field.

The Call History List contains a listing of recent calls for the Station. To
operate on a call record, left click on the desired call in the list and use the
Toolbar to execute the desired operation. Alternatively, right-clicking on a
call record pops up a handy quick menu including all the functions of the
Toolbar in addition to items in the File and Edit menus.

To play back a call, left click on the desired call then use the playback
controls at the bottom of the screen. Along with basic play, pause and stop
controls, playback time and volume can be changed by use of the slider
controls (refer to “Tools Menu Functions” on page 15).

www.algosolutions.com



The ECR Station Viewer Interface

Call History List
Column Descriptions

Start Time
Duration

Set Display

Comments

Type

User

Protect

Locked By

Call Record File

Format

The Call History List list displays all of the relevant information related to
each call record. This includes the start time, duration, set display, user
entered comments, type of call, protection status, call record filename, and
the file format (wma or wav).

* Clicking on each column heading automatically sorts the call records.
You can use this feature to easily sort or locate calls.

* Each column is resizable. Just click on the border between two column
headings and drag to the desired size.

* By selecting a call record and right-clicking, you can play or email the
record, add or edit comments, edit set display text, delete the record,
protect the record from automatic deletion (or unprotect it), save the
record as an external file, or copy the record to another directory.

* Because ECR call records are Windows files, they can be selected, cop-
ied, or dragged-and-dropped from the Call History List to different
folders, back-up media, emails, or your desktop.

Time and date of the start of the call.
The duration of the recorded conversation with one second resolution.

Contains outbound dialled number and inbound Caller ID. Other details
may be captured depending on telephone technology and the model of the
attached recorder device.

During a call, comments can be added in real-time via the comments filed
in the Telephone Status Panel. After the call is completed, comments can be
added to the call record by using the Comments command in the Toolbar
or by right-clicking a call record and choosing Comments.

Type of call: Outgoing, Incoming, or Missed Call.

Note: The type of call is based on the ring cadence detected at the
telephone. For systems where the telephone does not ring, or only provides
a single alerting tone on an inbound call, some calls may be incorrectly
flagged as “outbound”.

The name of the User for which the call was recorded.

The status of the Protect flag. If protected, the record will indicate ‘YES'.
Indicates whether the call record is locked and, if so, by what user.

The file name of the call record file.

The type of call record file. The default is .wma (Windows Media file).

ECR Station Viewer User Guide 6



The ECR Station Viewer Interface

Call Finder

Searching Station

Date

Comments

Set display

Length of call

Station View Statistics Call Finder
Search Options
Station: | <Al Stations> v
Sharter than: Longet than!
From: [[v 20050528 1200:00 aM +| To [V 20080622 1150:59 P | i [ =
St Display: [ Comments: [ Call Type: [ User:

ABC Incoming %

Found 2 calls matching search criteria (of 148 on disk)

Start Time:
2009-05-23 03:59:19
:24:01  00:04:05

Duration

Incoming

AnalogPhone

Call Finder is a powerful search utility that allows for easy retrieval of calls
in the database. Call Finder displays all calls in the database that meet the
specified search criteria. All matches will be displayed - there is no limit to
the number of records that can be listed.

For example, if no criteria are selected, executing the search will display all
call records in the database at the time that the search is started (this differs
from the Station View which normally lists only a limited number of the most
recent calls, but updates as new calls are created).

A number of search parameters are accepted to perform a search as
defined below:

Allows Station specific or global searches. Stations not included on the
User’s allowed Station list will not be accessible from the Call Finder.

The calls searched will be limited to the interval between the dates specified
in the Calls From and Calls To fields. Default value interval is all calls
recorded since installation

Allows search based on user-entered comments. Any portion of the call
record comment matching the search parameter will return a positive
match.

Allows search based on set display information (Caller ID and dialled
number).

For example, searching by area code can quickly return all calls from a
particular region.

Searching a complete phone number will return all call records with that
number appearing in inbound (Caller ID), or outbound (dialled on
telephone)

Searches can be based on call durations. Common uses are to screen out
short calls or search for abnormally long calls

www.algosolutions.com



The ECR Station Viewer Interface

User Allows limiting of search to all made by a specific User. Note that the User
must be logged in as an Operator while taking calls to have User
information appended to the record

Call type Allows limiting of search to Incoming, Outgoing, or Missed Calls.
Statistics
Station View Statistics call Finder
Statistics Parameters
Station: | <Al Stations=> v

From: |Vzoog.ua.m 12:00:00 AM j To: ||7 2009-06-22 11:58:59 PM j Generate statistics report

Report

Jun 1, 2009 - Jun 22, 2009

Longest call: 01:04:16
Shortest call: 00:00:02

Incaming (3 calls)

2% W utgoing (49 calls)

W Missed (9 calls)
Imported (0 call}

Oldest call: 01-JUN-2009 08:34:07
Average call duration: 00:04:12

ECR keeps track of telephone usage and can provide interesting and useful
statistical information. Depending on what privileges a user is granted,
data can be calculated based on all Stations, specific Stations, or the
current station. Data can also be limited based on a range of dates.

To access this information:

Click the Statistics tab, or select View> Call Statistics.
Select the desired Station setting.

Choose the desired From and To dates.

Click the Generate statistics report button.

e

Available statistical information includes:

*  Number of telephone calls made outbound
*  Number of telephone call received

*  Number of missed telephone calls

*  Number of imported calls

* longest, shortest, and oldest call, and

* Average call duration

Data appearing on screen can be exported to

Microsoft Excel® using the Export to Excel feature Hardware Maintenarce...
. h. P d...

found in the Tools menu. el

Recording System Commands. ..

Export Data To Excel...

Options. ..

ECR Station Viewer User Guide 8



The ECR Station Viewer Interface

Player Panel

Playback File

Playback Progress
Slider

Playback Progress
Summary

Playback Buttons

Volume Slider

Play Speed Slider

Playback Progress Play Speed

Playback File Summary Volume Slider Slider
Player

as 1.0 1.5 2.0
File: [__stnD10_200906197143512.%ma 00:00 / 0n:00 Ll A Yolume: Jf Play Speed: ]7

]

X

Playback
Progress
Slider

Buttons

Play —

Playback

aybad |:Pause
S

Use the Player Panel to control and monitor the playback of a selected call
record. The Player Panel includes the following information and controls:

Provides the name of the currently selected call record file.

Provides a visual timeline indication of the playback progress and also
allows you to quickly jump ahead or back to sections of the call record file.
To use the slider, left-click click the slider, hold the mouse button down, then
drag the slider to the portion of the call record you want to listen to.
Alternatively, you can left-click anywhere on the timeline to make the
playback jump forward or backward.

Provides information of how long the current call record file is and how far
along the the playback has progressed (in minutes and seconds).

Use the basic Play, Pause, and Stop buttons to control the playback of the
call record file.

Drag the volume slider to control the playback volume of the call record
file. If you are unable to generate enough volume, try adjusting your PC
audio settings or turn up the volume controls on your speakers.

This control allows you adjust the speed of the playback of the call record
file with minimal effect on the clarity of the content. A slow speed is useful if
you have to type out a written record of a file and want to ensure the
conversation is slow enough for you to keep up. A faster speed allows you
to quickly scan through a file to find a particular piece of information.

www.algosolutions.com



Call Record Context Functions

Call Record Context Functions

Call Record context functions are available for use when R

a call record is highlighted in either the Station View or Email.

Call Finder. The complete list of call record functions is ;Z:::E:;
available by right-clicking on a call record. A subset of s
these functions is also available from the Toolbar. In Unprtect
addition, when a call record is highlighted, the Play ok
function can be accessed from the Player Panel at the Edic Set Display. .
bottom of the screen. o
Note that unless a call record is highlighted, all toolbar select Al

icons will be greyed out.

Note also that not all Call Record context functions may be available to all
users. This is because the privilege to use these functions is set by the ECR
System Administrator. Contact your system administrator if you do not have
the priveleges to use any of the following functions.

Play

Plays back a call record file. For full playback control of call records, refer
to “Player Panel” on page 9 .

52 Email

E-mail

Call records may be easily emailed as attachments by simply highlighting
one or more call records and choosing the Email function. A new email
composition window will open (using your default email software) with the
call record(s) pre-attached. In addition, the call detail and comments are
inserted into the text body.

Note: In order to use this feature, a MAPI compliant email program must
be installed. Microsoft® Outlook® and Outlook Express® are configured
correctly by default, however Netscape® requires the MAPI option to be
selected in the email program setup. Email signature attachment is only
supported with Microsoft Outlook.

Standard Windows controls work in the Call List window to select multiple
call records - for example, holding the CTRL key while clicking the selected
call records you wish to email.

ECR Station Viewer User Guide 10



Call Record Context Functions

ECR will also include an “Algo Recorded” line of text in the email message.
This text line may be deleted manually and set to not be displayed by
unchecking the Display Recorded message checkbox in
Tools>Options>User Display Settings.

Any of the automatically inserted text may, of course, be edited or deleted if
you do not wish to share this information with your recipient. Keep in mind
that this information is also embedded in the audio file (e.g. comment text),
but will not be retrieved by Windows Media Player.

& Comments

Comments

Adding comments to a call record not only helps summarize the contents of
a call but also makes search and retrieval much easier at a later date.

Anytime while recording a call, comments (up to 200 characters) can be
typed into the Comments bar in the Current Call section of the Station

View.
User: jrutledge
] ﬂ Set Display: F'ﬂ45551234

Comments:  [This is a sample corment | Csave

00:00:17

Once a call is saved,
comments may be added or
edited by selecting the

®] Edit Comments

Enter Comments

Financial statements discussion with Bob

Comments function. You can o 200 s
then add or edit text in the

Comment text box.

Comments are embedded into call records, just like Caller ID and other
data, to be retrieved by Client Call Recorder.

Quick Find

8
Quick Find

The Quick Find function
allows you to quickly search
all the fields in the displayed
call list in the current view

window (can be Station View
or Call Finder Views). The

¥ Quick Find

Search For:

|acme | [ search ]

www.algosolutions.com 11



Call Record Context Functions

function highlights any call records in the current view window, from ANY
field, that match the text entered in the Quick Find search box. Note that for
full search capabilities on all calls in the local ECR database, use the Call
Finder function.

% Delete

Delete
The Delete function allows you to delete one or more call records that have
been selected in the Call List window. Note that the delete key on the
keyboard will perform the same function. Note also that the Delete function
will not delete protected records. To delete a protected record, first
unprotect the record, then delete it.

Protect
x|

Pratect

Allows you to protect a call record so that it cannot be deleted (manually or
automatically) within the ECR system. This feature ensures that a call record
will remain in the ECR database even if the Automatic Delete function is set.

In addition, protected call records will not be counted as part of the
Number of Calls limit set for the Automatic Delete function (if used). For
example, if you have set the Number of Calls limit to 20 calls and have
protected two calls, you will store the two protected calls plus the 20 most
recent calls.

To protect a call record, select the record then choose the Protect function.
To manually delete a protected call record, first unprotect it, then delete it.

7% Unprotect

Unprateck

Disables the Protect feature.

ECR Station Viewer User Guide 12
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8 Lock

Lock

Prevents the call record from being played, emailed or viewed by other
Operators.

y Unlock

Unlock.

Disables the Lock feature.

Edit Set Display

Allows you to edit the
automatically-generated text in a __

, . : Maodify Set Display information
CO” reCOI’d s set dlsp|0y fleld, up |1a775553030ABchrp\
to a maximum Of 200 (Maximur 200 characters)
characters.

®] Edit Set Display

Save As

Allows you to save a call record S — e

u.nder a dlffer.en’r name or to a - I3 TR
different location on your g
computer or storage media.

File name: [ stn10_200906207 21571 4.mmd] | [ sae |

Save as lype: |_wma vl [ Cancel ]

www.algosolutions.com 13



Call Record Context Functions

Copy

Allows you to copy selected call
records to a different directory
on your computer or storage

. . . . (=T
media. To use this function, first Sregnie:
select the call records of interest (T
from the Station View or Call
Finder views, choose Copy, then

select the target folder to copy
o

Select All

Selects all the call records in the currently displayed call list.

ECR Station Viewer User Guide 14



Tools Menu Functions

Tools Menu Functions

System wide options and control is available from
Hardwars Maintenance. . the Tools drop down menu. Each feature available
Change Password, .. . . . .

i from this menu item is detailed below.

Export Data To Excel...

Options. ..

Hardware Maintenance

If there is recording hardware attached to your PC, the Hardware
Maintenance interface provides access to these devices for programming
firmware and Serial Numbers.

Note that before accessing these
devices, the recording system will
need to be temporarily shut down.

Enterprise Call Recorder,

t Ta program your recarding devices, your recording system will need to be
LY

temparatily shutdown. Procesd?

All recording devices attached to
the PC will be listed in the
Maintenance window. The Serial Number, Firmware Version, and Type of
Algo Recorder are listed.

Recorders can be disconnected or g - )
connected to the PC with the e

maintenance window open. Click
the <Refresh List> button to
update the listing.

4102 Dighsl BavCard
4302 D e
]
2 4302 Dkl AanCard
2 4102 gkl AuseCard
2 002 Dt AaCand
D A0 Dgtal A
2 4302 Dkl AanCard
2 4102 Dighal useCard
2 a0 Dl e
2 A0 Dt dCard

To program a recorder, left click on
a listed recorder. The lights on the
front of the selected recorder will

flash when selected. Then click on
the buttons at the bottom of the window to perform the desired operation.

To upgrade the Firmware of all attached 4102 AuxBoxes and 4102R
AuxCards simultaneously, right click on any listed recorder and select
<Upgrade all 4102 AuxBoxes>.

fffiddgiidadida

Faine | [ s | [[Propem se et | Com

www.algosolutions.com
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Tools Menu Functions

Recording System Commands

This function allows you to start, shut down, or
restart any call recording hardware you may
have attached to your PC. Use these
commands with caution as critical call
recording can be disrupted.

B Rocording System Commands

Recording System Running

Comeoss | sttty
e S

=

Export Data to Excel

This function will export all data displayed in the view window to Microsoft
Excel. This function is available from all three main views of the ECR Station

Viewer (Station View, Statistics, and Call Finder).

Change password

Allows the currently logged in User
a quick means to change their
pCISSWOI’d . Username:

Old passward:
MNew password: {Case sensitive) RRRRR R

Confirm new password: Aotk

::’J] Change Password E|

ﬁ'rut\edge

dokskekiodotk

Ok ] [ Cancel

ECR Station Viewer User Guide
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Options

Options

User Display Settings

Email Settings

This tab includes options for controlling
how many recent calls will be displayed
in the Station View’s Call History List of
call records. In addition, this tab allows
you to set the format of the date display
of call records and to control the
automatically-inserted text that goes into
generated emails.

The settings in this tab apply to the
Station View window for the user’s ECR
Station Viewer as well as for the ECR
Supervisor (if enabled for that user).

The display of calls can be limited by:
*  Number of calls (up to 999)

e 4tgs | P | Mot Corfigwaens |
User Display Settings Peiurdrsy | ol Rpcerd Sorage |

‘Station List Display settings

For . specky hom far u
s your st imomrt €l The cill chijiirped i b bt by rasiboer oo by the
Vi s crested.

oF eali.

2 Desphay cals cresbed dureg the ast defined peviod of time. (Maimum 31 days)
sy -t i -l
T 0 =

Date Tine Formak: | (0-MMMAYOTY HAEMM:SS »

* Period of time (up to 30 days for the ‘Days’ drop-down box, and up to
24 hours for the ‘Hours’ drop-down box)

* The Enable Signature Display setting allows you to automatically
include Email signature text (from your email client) into any emails sent

from ECR.

* Unchecking the default “Algo Recorded” message setting allows you to
remove the automatically inserted message text (e.g. “This call was
recorded using an Algo 4105 Analog Auxbox with the Enterprise Call
Recorder V2.2 software”) displayed in the emails.

www.algosolutions.com
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Options

Station Settings

Hidden Mode

Record Missed Calls

Missed Call Delay

Recording Format

The Station Settings tab allows

®] System Options EJ
users 1‘0 Set User Display Settings | Recarding | Call Record Storage |
i Station Settings } Filtar Calls | Auxbio: Configuration |
* the status of the Hidden e —
Mode

[ Hidden Mode  {Disables the system tray icon)

* whether Missed Call
records will be generated
and, if so, the time delay
OSSOCiGTed WiTh generOfing (Mumber of seconds ko wait after the ring stops, in order to

consider that & missed call happened. NOTE: Typically 4-5
those records s
* the audio recording format

Record Missed Calls (Generate a call record for every missed call)

Missed Call Delay |5 |~ (Maximum 30 seconds)

. ) . Recording Format: @ WA Oy
and associated file size and o
- WA Encoding Audia Profils:
compression for the call Dot e Conpression M) r
record files
oK ] [ cancsl | [ apoly

This option disables the Windows system tray icon for the station.

You can choose to have ECR log missed calls or not for the station. A log
of missed calls can be very useful to gauge telephone activity.

When enabled, ECR will generate a missed call record whenever the
telephone rings but is not picked up. This record stores the time and date of
the call as well as Caller ID information.

Note that logging missed calls should be
disabled when a single inbound call rings
multiple telephones, as in hunt groups, to avoid
large scale generation of missed call records

This option defines the interval ECR waits at the end of ringing before a
missed call record is generated. The adjustment compensates for ring
cadence variations and delays between ring and the telephone in-use
events. Adjust the detection delay if missed calls are generating multiple
records. Note that while the time delay can be set for up to 30 seconds, a
typical setting will be 4 to 5 seconds.

ECR allows calls to be stored in
either WAV format (raw 8kHz, 16bit
data) or compressed Windows
Media Audio® (WMA). The WMA
data rate is selectable from pull
down menu. WAV recording
provides the best recording quality,
but consumes storage space very quickly: 29 MB per hour.

Recording Format: () WM Cweay

WA Encoding Audio Profile:
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The WMA recording compression can be set to either 3MB or 5MB per
hour. The 5MB per hour setting offers improved audio quality at the
expense of increased storage usage.

Filter Calls
Designed for usewhen the Save Mode g
is set to Automatic Record, the Filter e
Calls function can be used to avoid
automatic recording of routine calls ot mte g e St ki s
such as personal calls to or from a
home telephone. Note that users can e e
override this function and manually save il
files, if desired. panen s
S
S
e | [Ccama | [ et |
Filter by patterns Up to ten different phone numbers (or alphanumeric strings or 'patterns'
P P p g p

can be entered into the Filter by patterns list that will be used to prevent
calls from being automatically saved.

This function works by searching for the pattern in the set display. Thus, you
can enter partial text or numbers instead of exact phone numbers or
names. If there is a match, the call record is not saved.

Note that ECR will look for any match, so if you enter just "9" in the Filter
Calls list, any number dialed that includes a 9 will not be recorded. Make
sure you test your Filter Calls string to ensure you get the results you intend.
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Recording

Save Mode

Phone HotKeys

Save Key

Record Key

The Recording tab allows users
to set:

)
=

System Options EJ

Station Settings | Filter Calls |

Auxbox Configuration |
Liser Display Settings Recording |

Call Record Storage |

Sawe Mode

* whether calls will be saved
automatically - or manually
by the user

* what phone or keyboard
keys users can use to trig-
ger the manual saving of
call records or the setting
of the call record protect
flag

* what key can be used to
toggle recording on or off

(&) Automatic Record 3 Manual Record

Fhane Hotkeys

Enable Save Key
Saves entire conversatian, same as the keyboard
Hotkey when in Manual Record Mads, of sets the
Protect flag when in Automatic Record Made.

Definition:  Press * followed by <6

Enable Record Key
Toggles recording on or off, recording each portion
a5 a separats call. Overrides Automatic or Manual
Record Modes when pressed,

Defirition: Press # followed by <8

keyboard Hotkey

Enable Keyboard Save Key Select: |Fz v

Definition:  <F22

ok | [ cancel ] [ apehy

Sets the Station Save Mode to either Automatic Record or Manual Record.

In Automatic Record mode, ALL station calls (including inbound, outbound,
and missed calls) are automatically recorded and saved to the ECR
database with the exception of:

* calls where the set display matches any of the patterns in the Filter Calls
list, if configured
* Missed calls if the Record Missed Calls function is turned off .

In Manual Save mode, only those calls a user manually selects are saved
into the ECR database.

ECR supports two types of on-demand recording: Entire save (Save Key);
and toggle record (Record Key).

Press the Save Key to store an entire call at any point during the
conversation, or after the call has ended. ECR caches the last conversation
to allow the call to be saved. A new call deletes the cached previous call.

Note: This feature is useful in Manual Mode as it allows the unsaved last
call to be saved.

The Record Key allows a portion of a conversation to be stored as a call
record. The first press of the Record Key begins audio recording from that
point. A second press will stop recording and generate a call record
containing the enclosed portion of conversation.
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AuxBox Configuration

Select AuxBox Relay
Modes

Select Audio Level

Audio Recording

Select Speech
Decoding

] System Optios

The AuxBox Configuration tab allows
you to set various relay modes for a e
. , Station Sattings | Fitor Calls

station’s AUXBOX or AUXCO rd Seieuk Ausbor Relay #1 Mods

M . iR I Messaye Wakig ) bl
hardware, select audio levels, audio o [ o
recording modes, and speech LR I K
decoding modes.

Call Recoed Storage
Apebecoe Configuration

Sedoct Aurbeors Rerkyy #2 Mode

o Racordng

The relay output(s) on the Station recorder can be configured to activate on
different telephone states.

Depending on the AuxBox recorder attached, some selections may be

disabled.

'All Modes' activates the relay on all event triggers with the exception of
'Save Activated'. Fast flash for Ring, on solid when In-Use, slow flash when
a message is waiting.

'Save Activated' mode call is triggered when a call is set to be saved - either
because the station is operating in automatic save mode or because
manual recording has been triggered.

The digital and analog audio level is adjustable between two levels: Low
and High. The low level provides more dynamic range for improved quality.
The high maximizes audio gain to correct for low source audio levels.

Audio output can be limited to receive audio only for applications that do
not want the near side caller recorded. Radio call-in shows and radio
dispatching are common uses for this feature.

Audio on Nortel digital TDM telephones is encoded differently depending
on region. For North America, this setting should be uLaw. In Europe, the
setting should be alaw.

Improper configuration of this setting will result in recordings that are
unintelligible and garbled.

www.algosolutions.com
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Call Record Storage

Limit Call Storage By

Cautions

Limiting by Number of
Calls

Limiting by Number of
Days

Limiting by Storage MB

To help manage call record files, ECR

&) system Options
includes several options to help keep sy | wck | scotaren |
storage requirements low. You can Lot ot ra . S
choose to automatically delete call OMmbwdbos [t Ommbach i
record files based on how old they SRS M

are (number of days), how many
there are, or how much hard disk
space (in MB) they take up.

[ ] [coma ] [ 5 ]

The size of the call record database can be limited in three ways:

1. By call record date
2. Number of call records in the database
3. By disk space used

When limiting by number of days, call records older then the defined limit
are automatically deleted from the call database.

When limiting by number of calls or disk space, the oldest calls are deleted
automatically once the defined limit is reached. If you set the system to
automatically delete records based on days, number of calls, or storage
space, keep in mind that there is a risk that you could occasionally delete
wanted files. Therefore, it is important to set these conditions properly.
Consider the following problematic cases:

If someone calls the station fifty times one day while the user is out, it may
prematurely push important records into the recycle bin.

If the user at the station has a schedule disruption, like an extended
business trip, some of the call records they may have been expecting to
review upon return may have already been deleted.

If a user at the station has one or more lengthy conversations that use up a
lot of memory, it may prematurely push important records into the recycle

bin.
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